DocScan

PACS Document Scanner
Current Version: 2.0.7

Purpose:
DocScan is a document scanning program for converting paper documents and image files to DICOM
objects and importing them into PACS. DocScan incorporates “modes” which are profiles for how a
scanned document should be converted and sent to PACS. DocScan supports archive queries and
modality worklist queries for sending exams to PACS. DocScan should work with any TWAIN
compliant scanner and also supports the Fujitsu ScanSnap S510 (non-TWAIN compliant) page fed
scanner.

Workflow:
DocScan can either be integrated with Emageon PACS (via shortcut key, viewport button, context or
system menu) or used as a standalone product. Changing modes or launching in standalone is done with
the DocScan icon located in the system tray:

DocScan can send the same scanned documents to multiple studies by presenting the end user with a
check list of query matches:
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The DocScan scanning window looks like this:

Clicking one of the thumbnail buttons starts the scanning. Depending on your INI file settings, your user
may be presented with an option to scan a single page or multiple pages. In the end, the large portion of
the window will display the scanned document with the thumbnail image(s) down the side:

After an initial scan you can click any of the empty thumbnails to scan in more documents.
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There are six thumbnail placeholders down the right side of the DocScan window which have the
following context menu options for manipulating the images they represent:

Delete: Removes the image
Import: Lets the user browse for BMP or JPG files to import instead of scanning images.
Rotate 180: Rotates the image 180 degrees incase it was scanned upside down.
Invert Image: Makes a negative of the original image.
Convert to grayscale: Converts a color image to grayscale.
Edit image in IrfanView: This option lets the user have full access to the image editing options in
IrfanView. There are a wide range of cropping, filtering and image enhancement options in
Irfanview. Be sure to save the picture with the File -> Save option before exiting IrfanView so that
the image gets updated in DocScan.
(Note: You have the option of removing any context menu options you don’t want on a per mode basis.)
Currently, DocScan only supports 6 images per document scanning session. If you load 7 pages in your
scanner, DocScan will ignore the 7th page. In developing this tool for my site, it was rare that we needed
to import more than six documents at a time so I limited it to that. In a future release I plan to add an
option to expand the number of thumbnail buttons if more are needed.

Setup:
(Note: I have not created an installer for DocScan yet because I am adding features into the program at
a rate faster than I currently want to spend time recreating setups for it. When the development cycle
slows down I will create an installer that performs the following steps for you. Until then here are the
steps to manually perform the install.)
1) Download DocScan from http://www.pacsmatt.com/programs/DocScan/DocScan.htm.
2) Unzip the file to the C: drive. You should end up with the following folder structure (and some
additional files depending on what’s in the latest release):
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(Note: You should be able to install DocScan to a different folder, however I have not tested this.)
3) Make a shortcut to the DocScan.exe file and place this shortcut in the All Users Startup folder:

4) All the settings for DocScan are contained in the DocScan.INI configuration file which you must
modify before using DocScan. Here is the DocScan.INI file included in the zip file. At a
minimum you must modify the highlighted items in order to get DocScan working with your
PACS. There are many more options to configure to make DocScan more useful so be sure to
reference the “DocScan INI Options” section, later in this document.
DocScan.INI file:
[TECHS]
John Jingle|JJ=
Mary Ray|MR=
Other Tech|OT=

Operator initials can be added to an
exam via a drop down list. At least one
tech must be listed in this section.
Tech initials can be optional or
required. Each line must end with an =.

[COMMON]
PACSARCHIVEAE=PACS_SCP
PACSARCHIVEIP=10.20.30.40
PACSARCHIVEPORT=104
PACSMWLAE=PACS_MWL
PACSMWIP=10.20.30.41
PACSMWLPORT=5004
CallingAEtitle=DOCSCAN

Fill in the values for your PACS archive
and modality worklist server AE title,
IP address, and port number.

The AE title DocScan will appear as to
your PACS.

[MODES]
WORKSHEET=

This is a list of Modes you want
available in DocScan. Each must end
with an =. There must be a
corresponding section with the same
name for each Mode that is listed here.

[WORKSHEET]
MODE=/gray
SERIES=999
SERIESDESCRIPTION=Worksheet
SCANPAGE=SINGLE
InstitutionName=Hospital Name
QueryType=Archive
DaysToQueryPACS=2

Specific settings for “WORKSHEET” mode:
Converts the image to grayscale.
Series number to apply to the image.
Series description for the image.
Puts DocScan in single page mode.
Institution name added to DICOM header.
DocScan will query the PACS archive.
Number of days DocScan will search
PACS for the queried study (based on
MRN).

Page 4 of 19

Version 2.0.7

(Updated: 9/24/2008)

5) (Optional, but nice!) Here is how to integrate DocScan into the Emageon PACS viewport
interface. Do this to your user’s inheritance account so that you only have to set it up once and not
on each individual user account.
a. After you have performed the above steps, run Emageon PACS and go to File ->
Preferences -> Macro Manager
b. Click Add, name the Macro “Scan Document” and click OK.
c. Click Add again, choose “New OS Action” and click OK.
d. Name the OS Action “Scan” and leave the Working Directory blank.
e. Copy and paste the following text into the Command(s) field:
C:\PACSMATT\DocScan\dsTrigger.exe "{StudyDate}" "{StudyTime}"
"{AccessionNumber}" "{Modality}" "" "{ReferringPhysiciansName}"
"{StudyDescription}" "{PatientName}" "{PatientID}" "{PatientBirthDate}"
"" "{StudyInstanceUID}"

(Note: DocScan will not function correctly if this text is not copied exactly.)
f. Leave the “Allow multiple instances…” box checked and click OK, OK, & Close.

g. The dsTrigger.exe file is used to pass exam demographics to the DocScan application.
h. Now add a method for your user to launch this macro. This could be a shortcut key,
context or application menu option, or a viewport button. I will describe how to add a
viewport button, modify this as needed if you want a different method.
i. Go to File -> Preferences -> Customize Image Display user Interface
j. Click the “Secondary Toolbar” tab and click the Add button.
k. Choose “Macro: Scan Document” from the list and click OK.
l. Click the new “Scan Document” option in the button list and choose Edit.
m. Choose an icon (I like the clipboard icon for DocScan) and click OK.
n. Use the arrow buttons to move the new button to where you want it and click OK.
o. To enable Emageon PACS integration, be sure that the DocScan.INI file has the following
option in the [COMMON} section: MACROINTEGRATED=YES
6) DocScan uses the program IrfanView to do the actual document scanning with TWAIN devices. I
find you have to manually do one scan with IrfanView before DocScan is able to use the scanning
device. Follow these steps:
a. Browse to C:\PACSMATT\DocScan\Resources \IrfanView and run the i_view32.exe file.
b. Click File -> Select TWAIN source, choose your scanner and click the Select button.
Page 5 of 19

Version 2.0.7

(Updated: 9/24/2008)

c. Click File -> Acquire/Batch Scanning,
d. Choose the “Single image…” option, click OK and follow your scanners steps to scan any
test document you want.
e. Discard the scanned image and close IrfanView.
7) That should do it. Run DocScan by double clicking the DocScan.exe file (it will launch
automatically in the future because of step #3). Test out DocScan by either by clicking its system
tray icon and clicking “Query PACS and Scan Document” or use the PACS integrated button.

Adding More Modes:
The initial DocScan.INI file only has one mode. Try adding the following changes to your
configuration to add more function:
[MODES]
WORKSHEET=
REQUISITION=
[WORKSHEET]
MODE=/gray
SERIES=999
SERIESDESCRIPTION=Worksheet
SCANPAGE=SINGLE
InstitutionName=Hospital Name
QueryType=Archive
DaysToQueryPACS=2
[REQUISITION]
MODE=/gray /invert
SETMODALITY=OT
SERIES=100
SERIESDESCRIPTION=Scanned Requisition
INITIALPROMPT=YES
SCANPAGE=MULTIPLE
MultiPagePromptDelay=5000
InstitutionName=General Hospital
DaysToQueryPACS=3
QueryType=ARCHIVE
StackImagesInSeries=FALSE

This new “Requisition” mode will:
• Convert scanned documents to grayscale and invert the black & white.
• Force the modality to be OT.
• Set the series number in PACS to be 100.
• Set the series description to “Scanned Requisition”
• Force the user to select their initials from the Tech drop down menu.
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•
•
•
•
•
•

Sets DocScan to use a page fed scanner so it can import more than one document at a time.
Sets the delay before the user sees the multi-page confirmation prompt (see the “DocScan INI
Options” section for more details).
Sets the DICOM header InstitutionName to “General Hospital”.
Queries PACS for three days worth of studies that the scanned documents might need to be
attached to.
Performs an archive query, e.g., it is searching for existing exams (images) in PACS to attach
the scanned documents to.
Multiple scanned images will be in unique series, beginning with 100 (because we set it as
that) and counting forward by one: 100, 101, 102, etc.

Notes:

¾ Remember that for each mode section you add, e.g., [REQUISITION], there must be a
corresponding entry in the [MODES] section, e.g., REQUSITION=.
¾ You can have as many modes as you need. So be creative. (Ok, there is some limit to the total
number of modes. I don’t know what it is). You need to exit DocScan and restart it whenever
you make changes to the MODES section of the INI file.

DocScan.INI Options:
Here is a complete list of the options you can configure in DocScan.
“Section” is the part of the DocScan.INI that the setting applies to.
“Option” is the option you are configuring (how else do I describe that?)
“Default Value” is the value applied if you do not set the option at all.
“Notes” are notes.
Section

Option

Default Value

Notes

[TECHS]

variable
Format example:
Mike Jones|MJ=

Do not enter a value
after the equal sign

At least one value must be in this
section for DocScan to run and each
line must end with an equal sign.
That’s a pipe ( | ) symbol in between
the name and initials.

[COMMON]

PACSARCHIVEAE

None

PACSARCHIVEIP

None

PACSARCHIVEPORT

None

PACSMWLAE

None

PACSMWIP

None

PACSMWLPORT

None

CallingAEtitle

DOCSCAN

MACROINTEGRATED

NO

IMAGEDIR

\DocScan\Images

Your PACS DICOM SCP AE title.
(Required)
Your PACS IP address. (Required)
Your PACS port number. (Required)
Your PACS DICOM Modality
Worklist AE title. (Required)
Your PACS DICOM Modality
Worklist IP address. (Required)
Your PACS DICOM Modality
Worklist port number. (Required)
Change the calling AE title if you
want to.
Either YES or NO. Decides if
DocScan is integrated with Emageon
PACS. “YES” will cause it to watch
for prompts from the macro launching
the dsTrigger.exe program.
This folder holds the scanned images
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RevertScanModeToFirstChoice

0

before they are converted to DICOM
objects.
When there are multiple modes
available in DocScan, this choice
decides when DocScan will revert
back to the primary mode (which is
the first one listed in the modes
section).
Setting this to zero, forces DocScan to
revert to the first mode after every
scan. This is useful in an environment
where users are expecting DocScan to
be in a certain mode, but there are may
be infrequent occasions where users
will need to scan in an alternative
mode.
You can also set this value to a
number of minutes that you want
DocScan to wait before reverting to
the primary mode.
1 = 1 minute wait
5 = 5 minute wait
0.3 = 18 second wait
If you don’t want it to revert, then set
this to some arbitrarily high number
like 20160 which 2 weeks.
Set to TRUE or FALSE. This will
create detailed log files in
\DocScan\Logs for troubleshooting.
They are full of patient data so don’t
leave this on after you work out the
kinks and be sure to delete old files.

DebugMode

FALSE

[MODES]

variable
Format examples:
REQUISITION=
SCANNED DOCUMENT=
MAMMO WORKSHEET=
DEXA=

None

[SpecificMode]

Note: there is no section called “SpecifiedMode”. I am referring to options in each of the Mode specific sections like
[REQUISITION] or [SCANNED DOCUMENT]
MODE
/gray /invert
This is a setting for image conversion

You must have at least one Mode
specified in this section and each mode
line must end with an equal sign.

options that you want automatically
applied to every image that is scanned
in that mode. If you don’t specify this
option the document will default to
grayscale and inverted black/white. If
you don’t like the default, use one of
the options below and stop griping –
this program is free for goodness sake:
Use MODE= with nothing after the
equal sign to leave the document in the
format the scanner scanned it in.
Use MODE=/gray to just convert to
gray.
Use MODE=/invert to make a
negative of the image.
These options are applied during
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SETMODALITY

CHECK

ModalityOptions

CR|DR|XR|US|MR|
CT|OT|PT|MG|NM|
XA|RF|CHECK

ModalityDefault

OT

SERIES

99999

SERIESDESCRIPTION

Defaults to the PACS
Study Description.

ModPrompt

NO

ModQuestion

“Use modified exam
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DocScan’s command line image
conversion using i_view32.exe. There
are many more options you could
explore and apply here to
automatically do some conversion to
your images. Read the “Command
Line Options” section of the
i_view32.chm help file located in
\DocScan\Resources\IrfanView for
more details.
Set to CHECK, or a particular
modality you want to set the scanned
images to. CHECK will set the
modality to be the same as whatever
the queried study modality was, i.e.,
initiate DocScan in Emageon PACS
from a CR study and the scanned
document will show up as a CR image
as well. At the moment, CHECK only
works with Emageon PACS
integrations and modality worklist
queries. CHECK use with archive
queries initiated from the DocScan
icon will be added in a future release.
This is the allowed list of modalities.
If you need to modify this list make
sure it is a string of the modalities you
want to allow scanned documents to
go to PACS as separated with the pipe
symbol ( | ).
The default modality that DocScan
uses if the selected modality is not on
the ModalityOptions list or
CHECK fails to establish a unique
modality.
The series number that you want the
scanned documents to be assigned.
YES or NO. DocScan can prompt the
end user with a question hen they click
the send button. The question can be
modified with the ModQuestion
option. This feature is in place in case
you have a workflow need to make a
minor change to a submitted scanned
document’s series number. In our
case, we used this to ask techs if the
exam was eligible for sending to a
third party reading service or not. If
they answered yes to the question,
then the series number was changed to
the value in the ModSeriesTo
option. This allowed us to have an
extra PACS exam list based on the
modified series number to show exams
that were ready to be sent to the third
party reading service.
This is the question the end user is
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series number?”

ModSeriesTo

99099

INITIALPROMPT

NO

STATPROMPT

NO

STATPROMPTRED

NO

ImportOnlyMode

FALSE

SCANPAGE

PROMPT
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prompted with if the ModPrompt
option is set to YES. This option is
ignored if STATPROMPT is on and the
user answers YES.
The series number the exam is given if
the end user answers YES to the
ModQuestion.
YES or NO. Decides if the end user is
required to choose tech initials from
the DocScan Tech drop down menu.
YES or NO. If YES, after the user
clicks send they will be asked if the
exam is a STAT exam or not. DICOM
tag (0032, 000C ) “Study Status" is
then modified to either
LOW,MEDIUM or HIGH. It is set to
LOW by default, MEDIUM if the user
answers YES, and HIGH if the follow
up option STATPROMPTRED is
equal to YES. The end result of this is
that the exam gets marked as STAT in
Emageon PACS – the same as using
the “Priority” function in PACS and
setting the exam to Medium or High.
YES or NO. If YES, the end user will
be asked “Is this a ‘RED’ STAT
Exam?", otherwise, they will not
receive this prompt. If they answer
NO, the exam will remain in Medium
level priority (stat status).
TRUE or FALSE. Set to TRUE if you
want the default action of the
thumbnail button to be to import files
instead of using a scanner. Use this
option for situations where DocScan
(or a particular mode) is only needed
for importing images.
Either SINGLE, MULTIPLE, or
PROMPT.
PROMPT will ask the user if the want
to scan a single page or multiple pages
(I’m not sure if anyone would want
this mode).
SINGLE puts DocScan in single page
mode where DocScan is only
expecting to receive one page from the
document scanner. Use this for
flatbed page scanners. Do not use this
option with page fed scanners unless
you will never scan more than one
page at a time.
MULTIPLE is obviously for multipage scanning. Because of an
inconsistency in how scanners report
they are done scanning multiple pages,
DocScan needs a user confirmation
when the scanner is done scanning. In
this mode, DocScan will pop up a
message telling the user to “Click OK
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when the scanner has completed
scanning all the pages”. The message
appears based on the value of
MultiPagePromptDelay.
MultiPagePromptDelay

8000

ScanInterface

hidden

Number of milliseconds to wait before
showing the end user the message to
click ok when the scanner is done
scanning multiple pages. It is
important to delay this message or
users tend to click on it too soon. Try
to pick a value that will cause the
message to appear after a typical
number of pages are scanned. For
instance, we use this mode for our CT
scanner where they typically scan in 5
documents. This takes around 8
seconds, so we set this value to 6000
so that the message appears right
before the scanner is done scanning
and the user isn’t sitting around
waiting for a message to appear so
they can proceed.
This value is passed to i_view32.exe
when a scan is being performed.
Some scanners allow you to hide their
scanner interface so the end user is not
prompted to make scan option choices
from the TWAIN software. If you
want the scanner interface to appear
set this option to just be:
ScanInterface=

NoModFinalPrompt

beep

ModFinalPrompt

beep

InstitutionName

PACSMATT

DefaultImportDir

The user’s desktop
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with nothing after the equal sign.
A message can be displayed to the end
user after the images have been sent to
PACS. This particular value is
specific to images in which the
ModPrompt value was NO or the end
user clicked NO when prompted to
modify the series number. If this
value is in the INI and equal to
anything other than “beep”, DocScan
will display the text that this value is
equal to as a message the user must
click OK on. Use this if you need to
give any final instructions to the user.
Otherwise, DocScan will just give a
confirmation beep.
You can deliver a different message to
the end user if ModPrompt is enabled
and the user clicks YES to the prompt.
Use this if you need to provide
different instructions to the user for
cases where the series number gets
modified.
Better change this one or your
organization will appear to be
“PACSMATT” in the DICOM header.
This is the path to the folder that
DocScan should open first when
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DeleteImageAfterImport

FALSE

PrePopulateFromImageImportDir

FALSE

EmptyImageFolderOption

FALSE

DaysToQueryPACS

0

QueryType

ARCHIVE
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browsing for images to import.
TRUE or FALSE: Deletes original
imported images upon successful send
to PACS.
TRUE or FALSE: DocScan will look
for existing images in the
DefaultImportDir and import up to six
images with no user intervention.
TRUE or FALSE: Adds a tray menu
option to allow the user to empty the
folder specified in DefaultImportDir.
This is the number of days an archive
or modality worklist query will look in
PACS for other exams that match the
patient’s ID number. When set to
zero, DocScan will not attempt to
search for other exams (only use this
with PACS integrations). Set this to
any whole number that represents the
number of days back you might want
to attach the scanned documents to.
Pick a number that will narrow the list
of choices as much as possible. For
instance, if you are using DocScan to
scan in requisitions, you probably only
need this value to be 2 days because
scanning a requisitions should happen
right after the exam is complete (and
setting it to 2 days lets it find exams
that cross the midnight time frame).
Other workflows may require higher
values like a clerk adding a worksheet
to an exam possibly days after the
exam was performed.
Either ARCHIVE or WORKLIST.
When set to ARCHIVE, DocScan is
searching for existing PACS exams in
your PACS archive and the scanned
documents will be attached to those
exams.
When set to WORKLIST, DocScan
will query your worklist for scheduled
exams and it will use the worklist
responses to populate the exam details.
In general, use ARCHIVE whenever
you need to attach scanned documents
to existing exams in PACS and use
WORKLIST when the scanned
documents are the entire exam
(perhaps DEXAs or certain vascular
US studies?). The trouble with using
WORKLIST to attach exams to
existing studies in PACS is that some
modalities ignore the
StudyInstanceUID value that the
modality worklist provides and they
generate their own. Your scanned
documents will not attach to these
studies because DocScan will use the
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RestrictContextOptions

NONE

worklist’s StudyInstanceUID instead.
This allows you to restrict what
context menu options are available
with the thumbnail buttons in DocScan
(when you right click on these
buttons). Set this value to any context
items you do NOT want to appear to
the end user. For example:
RestrictContextOptions=
IMPORT|EDIT|INVERT

StackImagesInSeries

TRUE

SleepDelayMod

1

CropTop

0

CropBottom

0

CropSides

0

CorrectEmageonIntegrated
MacroValues (all one word)

TRUE
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This would remove the context options
for Importing images, editing images,
and inverting them.
Separate any restricted options with
commas, spaces or pipe symbols ( | ).
You can restrict IMPORT, ROTATE,
INVERT, GRAY, & EDIT, but not
DELETE.
TRUE or FALSE. When set to TRUE,
multiple images scanned (or imported)
with DocScan will be sent to PACS in
a single series with incrementing
instance numbers. When set to
FALSE, there will be one image per
series and the series number will
increase in value by one for each new
series (the first series number is still
the value in SERIES).
Some slower PCs may need to
increase this value to give DocScan
more time to process images. You
should not need to modify this value (I
have never seen a need to). However,
if you find DocScan is forming
corrupted DICOM objects, increase
this value to 1.5 or 2.
Specify a value from 0 to 0.10
representing the percentage (0 to 10%)
of the top of the image that you want
automatically removed.
Specify a value from 0 to 0.50
representing the percentage (0 to 50%)
of the bottom of the image that you
want automatically removed.
Specify a value from 0 to 0.10
representing the percentage (0 to 10%)
of the sides (both sides) of the image
that you want automatically removed.
TRUE or FALSE. When DocScan is
run through the Emageon macro
integration, Emageon will pass a
formatted name (Smith, Jane) to
DocScan instead of the DICOM
format (Smith^Jane^^^). DocScan
will convert these back to the correct
format before sending new images to
PACS. When this option is set to
TRUE, DocScan will compare the
converted name format to how it
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appears in any other same patient ID
exams that the query responds with
and that the end user selects. If the
name format differs, DocScan will use
the name format from the queried
response instead of the converted
format from the Emageon integration.
The following two values are specific
to using the Fujitsu ScanSnap S510
page fed scanner with DocScan:
SCANPAGE=S510

S510TIMEOUT

20

Setting SCANPAGE=S510 allows
DocScan to use the Fujitsu ScanSnap
S510 non-TWAIN compliant scanner.
There are some additional files that
need to be installed as well. Please
refer to the “Configuring DocScan for
the Fujitsu ScanSnap S510” section.
This is the number of seconds that
DocScan monitors the S510’s image
directory for new images. If the
images have not been scanned within
this timeframe, DocScan assumes no
images were scanned at all.

Configuring DocScan for the Fujitsu ScanSnap S510:
I bought a bunch of Fujitsu ScanSnap S510 document scanners assuming they were TWAIN compliant.
Assumptions… Really, how can a manufacturer be making a non-TWAIN compliant scanner these days?
Doesn’t that sound very 1990’s? Anyways, I was rather annoyed when I got these scanners and realized
they would not work with DocScan, but instead of sending them back, I decided to make them work.
They actually work very well. In fact, we have replaced almost all our scanners with these S510s and I
love them now. So here’s how to setup this Fujitsu scanner:
1) Install the Fujitsu software that comes with the scanner. You only need to install the ScanSnap
Manager and not the other two programs (unless you want them). I wrote these instructions
version 4.1 of SnapScan Manager.
2) Restart the computer as the installer recommends. Make sure your scanner is all plugged in and
There is a
turned on. If everything is going well there will be this icon in your system tray:
problem if you see this icon:
3) Double click the icon.
4) On the “Application” tab, click the “Add Profile” button. Name the profile “DocScan” and click
OK.
5) Click the “Add or Remove” button -> Click the “Add” button -> Select
C:\PACSMATT\DocScan\Nothing.exe for the Application Path-> Type “Nothing” for the
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Application Name -> click OK -> click Close.

6) Go to the “Save” tab and set the “Image saving folder” to C:\PACSMATT\DocScan\Images.
7) Click the “File name format” button -> choose “Custom File Name” -> set this to “DocScan” ->
set the Counter to “3 digit”.

8) Click the “Scanning” tab -> Choose your “Image quality” setting (I recommend Normal) -> Set
Color mode to “Color” (DocScan will convert to grayscale if desired) -> Set “Scanning Side” to
Simplex or Duplex (depending on what you need) -> Make sure “Continue scanning after current
scan is finished” is unchecked.
9) Click the “Options” button and uncheck all the boxes.
10) Click the “File option” tab -> Set the “File Format” to JPEG.
11) Click the “Compression” tab -> Choose a compression rate (I use ‘LOW’ because the image will
be uncompressed anyways as it is transformed to a DICOM object in Explicit Little Endian
transfer syntax.)
12) Click OK to exit.
13) These changes are saved in the following two folders:
C:\Documents and Settings\Logged in user’s name\Application
Data\Fujitsu
C:\Documents and Settings\Logged in user’s name\Application
Data\PFU
As you can tell, these settings are user specific. To avoid setting this up for every user you have
on a particular PC, copy these two folders and paste them into each existing user’s “Application
Data” folder in C:\Documents and Settings. Also, make sure you copy these same two
folders into the C:\Documents and Settings\Default User\Application Data
folder so that new users will inherit these settings appropriately. You can also copy these folders
to other computers that you set up Fujitsu S510s. You might want to wait to copy these settings to
other users/PCs until you have tested that the settings are working correctly.
14) Make sure the SCANPAGE value in the DocScan.INI file is set to S510.
15) Add/adjust the S510TIMEOUT value in the DocScan.INI file to reflect the number of seconds
DocScan should wait for the scanner to finish scanning images. DocScan is watching for the
images to appear during this timeframe and will terminate waiting as soon as it sees the images
appear from the scanner. This timeout value is only invoked when no images are seen from the
scanner in that timeframe and DocScan then assumes that no images were scanned at all.
Page 15 of 19

Version 2.0.7

(Updated: 9/24/2008)

16) Test out DocScan! When you click the thumbnail to scan an image, some green text will appear
informing you to press the Fujitsu scanner’s “Scan” button”. After the scan is complete the
images should appear in the thumbnails.

Known Issues:
1) Let me know what you find!

Future Enhancements:
1) Increase the number of available thumbnail buttons so more than 6 images can be scanned at a
time.
2) Ability to use CHECK option to discover modality for standalone archive queries. This is an issue
because the archive query will send back all the modalities that are in the study. This could
include PS, SR, OT, mixed CR/MR, CR/CT, etc. It’s difficult to try and guess which one is the
primary modality. I plan to fix this by having a preferred list of modalities which could be used to
exclude unwanted types like PS and SR. Evaluating mixed modalities like a combo MR/CR case
would be accomplished by choosing the modality that had the highest count in the study and in a
narrow margin of difference, by the order of the modalities in the preferred list.
3) Add MANUAL option to QueryType which would not do a query at all. It would prompt the end
user to fill in all the required fields in order to submit the study to PACS.
4) Add option to query PACS by accession number instead of patient ID.
5) Any ideas?

License Statement:
This program (DocScan.exe & dsTrigger.exe) may be used and/or redistributed freely, provided you
give me due credit and let me know how you are using it.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE.
Emageon, Inc. is not involved with the development of DocScan and therefore would not be able to
answer questions about it or provide technical support for it.
You have not purchased this program. Test it, evaluate it, and decide for yourself if it accomplishes
what you need. If you need something different or want a program for which you can hold someone
accountable for its function then purchase a different program that meets your needs. Otherwise,
please enjoy using DocScan

Version History:
- Version 2.0.7
 Update feature via "about" tray menu option
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 Fixed image resizing problem
 Added log time stamps to DICOM file creation
 Files are resized to compliant size before conversion
 Fixed error with EmptyImageFolderOption=FALSE
Version 2.0.6
 Remove +CA mod during image conversion
Version 2.0.5
 Added Instance Creation Date (0008,0012) and Instance Creation Time (0008,0013) tags
 Fixed problem with disabled controls when cancelling the option to import images.
 Added INI mode option for ImportOnlyMode=TRUE/FALSE for situations where DocScan will only be used for
importing image files. This makes the default action of the thumbnail buttons be to import an image.
 Can import bmp, gif, jpg, jpeg, png, & tif graphic files now
 Can select multiple images when importing graphic files.
 Added INI option DeleteImageAfterImport = TRUE or FALSE. Will delete all import images upon successful SEND to
PACS.
 Multiple imported images will be imported in ascending filename order
 EmptyImageFolderOption INI option (TRUE or FALSE) to add tray menu item for offering to delete the Image Import
folder of image files. If no folder is specified for a mode, no delete will be performed.
 PrePopulateFromImageImportDir INI mode option (TRUE or FALSE) causes DocScan to look for existing images in
the DefaultImportDir and inserts those images into the DocScan window with no user intervention.
Version 2.0.4
 Removed encrypted log of docs sent to PACS - logs are only available in DEBUG mode now.
 Combined DICOM sends for multiple images to one association (separate associations are still in place for same images
to multiple studies)
 Changed format of DEBUG log for easier viewing.
 Added full image tooltip to display what exams the images are going to be sent to.
 When archive of WL query selected choices are > 1 and if DocScan was started from an Emageon integration, then
DocScan verifies the name was correctly "unconverted" by comparing it to the 2nd queried choice.
 Fixed code for unstacking multiple documents, series numbers now increment by 1 for each new series.
Version 2.0.3
 Added StackImagesInSeries INI option - on a per mode basis, image stacking can be either set to TRUE or FALSE
 Corrected archive & MWL queries so correct calling ae from INI file is used.
 Added context option for editing image in IrfanView.
 Moved Log files to Logs folder.
 New transfer syntax conversion.
 Added DelayMod INI value for slower PCs.
 Added archive/MWL queries output to Log folder if in DEBUG mode
 Added option to remove button context options on a per mode basis.
 Optimized DICOM Tag modification to occur at DICOM file creation instead of after.
Version 2.0.2
 Added button context options to rotate, invert and convert to grayscale.
 Removed old code for file deletion
 Added error checking code for modality types.
 Added ability to default to specified modality.
Version 2.0.1
 Ability to import bmp and jpeg files
 Import and delete are now right click functions of the thumbnail buttons.
 Moved days to search archive to scan mode type in INI file. (Different search criteria can be used dependant on type of
document being scanned)
 Fixed query results window when results were equal to 0
 MWL Query
Version 1.9.0
 Added in ability to revert scan mode to first item in last after X # of minutes or to revert after every scan (set to 0).
Version 1.8.8
 Fixed Stacked scanned series being separated because of @SEC value in StudyIUID
 Added code so DaysToQuery can be zero and it won't search for priors.
 Embedded workstation IP in Series InstanceUID
Version 1.8.7
 Modified format of SeriesInstanceUID to be more in line with regular UIDs
Version 1.8.6
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 Done: Invalid Series Instance UIDs due to _UIshift value having leading zeroes, added the static value 9999900000 to
preceed the time.
 Done: Added customized Calling AE Title option in INI file for each report type.
Version Version 1.8.5
 DONE: "Sending Message" on screen
 Done: timeout on process check function
 Done: Fix code for if scan is cancelled and error checks for whether file was created or not.
 Done: Change Exit behavior to have confirmation prompt
 Done: Option to not prompt for Tech initials (use available if present)
 Done: More granular progress bar on status
 Done: Add results of jpeg conversion to detailed log file.
 Done: Added Mode to Title bar
 Done: Read Image Dir from INI file
 Done: dsTrigger to launch with macro integration
 Done: Multi-page scanning
Version 1.8
 Updated dsTrigger to Activate DocScan window if it goes to the background and the user reclicks the scan button
 Done: Add ExamMod change
 Done: Multiple Page prompt delay is now user configurable
Version 1.8.2
 Added:Support for custom mod messages
 Changed confinrmation message to delete GUI and provide audio feedback
Version 1.8.4
 Supports paging of stats and RED stats
 Marks exams with MED or HIGH STAT status
 S510 timeout value is variable in the INI file per mode type
Version 1.8.5
 Added "reduce memory" function
 Removed prior scans feature
Version 1.7
 Done: Added support for non-TWAIN compliant Fujitsu S510 document scanner
 Done: Added support for image cropping by Mode Type with INI values of CROPLENGTH & CROPSTART
 Done: About window closes after 60 seconds
 Done: Added Log viewer via tray menu
 Removed portion of DocScan label that had single exam specific info

Included Third Party Applications:
DocScan uses the following existing third party programs to process the image files. I did my best to
make sure it was ok to redistribute these files. If I am in error in distributing any of these files, please let
me know.
 STORESCU.EXE
 DCMDJPEG.EXE

From the OFFIS DCM Toolkit available at http://dicom.offis.de/dcmtk. These files are free from as far as I can tell. The
following paragraphs are listed in accordance with their Copyright text for redistribution:
* Copyright (C) 1994-2005, OFFIS
*
* This software and supporting documentation were developed by
*
* Kuratorium OFFIS e.V.
* Healthcare Information and Communication Systems
* Escherweg 2
* D-26121 Oldenburg, Germany
*
* THIS SOFTWARE IS MADE AVAILABLE, AS IS, AND OFFIS MAKES NO WARRANTY
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* REGARDING THE SOFTWARE, ITS PERFORMANCE, ITS MERCHANTABILITY OR
* FITNESS FOR ANY PARTICULAR USE, FREEDOM FROM ANY COMPUTER DISEASES OR
* ITS CONFORMITY TO ANY SPECIFICATION. THE ENTIRE RISK AS TO QUALITY AND
* PERFORMANCE OF THE SOFTWARE IS WITH THE USER.
*
* Copyright of the software and supporting documentation is, unless
* otherwise stated, owned by OFFIS, and free access is hereby granted as
* a license to use this software, copy this software and prepare
* derivative works based upon this software. However, any distribution
* of this software source code or supporting documentation or derivative
* works (source code and supporting documentation) must include the
* three paragraphs of this copyright notice.
 I_VIEW32.EXE

Irfanview is an excellent graphic file manipulation program that offers command line
support for TWAIN enabled scanners. It is available at http://www.irfanview.com.
Irfanview is free if you meet the author's stated requirements:
"IrfanView is provided as freeware, but only for private, non-commercial use (that
means at home). IrfanView is free for educational use (schools, universities and
libraries) and for use in charity or humanitarian organisations."
I contacted the author, Irfan Skiljan ( irfanview @ gmx . net - remove the spaces) about using and redistributing IrfanView
with Docscan and on 12/06/07 he replied:
"... No problem, you can use IrfanView for this, no costs :-)
The current IrfanView version is 4.10
Greetings/Gruesse/Pozdrav,
Irfan"
 JPG2DCM
 DCMMWL
 DCMQR

JPG2DCM is part of an open source DICOM toolkit and used to convert the jpeg images to DICOM files. It is available at
http://www.dcm4che.org/confluence/display/d2/dcm4che2+DICOM+Toolkit. It is free, open-source software. From the
website:
"dcm4che2 is a high performance, open source implementation of the DICOM standard."
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